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Environment Management System (EMS)

EMS Overview

Creo is committed to the Environment Management System (EMS). According to this policy, we are 
committed to keeping customers and service engineers informed about the principles of handling 
company products with an emphasis on environmental conservation.

The Triple-R principles are reduce, reuse, and recycle.

Any item that can be recycled should be recycled and any item that can be reused should be reused, to 
reduce the quantities of trash that municipalities must handle.

Recycling

Used items such as paper, plastic, electronic parts, and glass – should be sent for recycling.

Packaging Materials

Packaging materials will be kept at the customer’s premises. For disposal, they should be sent to a plant 
for paper, carton, and wood recycling.

End of Product Life

When the product reaches its end of life, it should be sent for recycling to a recognized company in each 
country. 
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Installation Guide Purpose
This Installation Guide has been designed to guide you through setting up 
your CXP6000 Color Server. It will also direct you in setting up client 
workstations to print with the CXP6000 Color Server, printing test files, 
and administrating your CXP6000 Color Server system.

Who Should Use This Guide
This Installation Guide is intended for CXP6000 Color Server operators 
and system administrators. 

Chapter Content and Description

Chapter Contents Description

Chapter 1 Setting Up Client Workstations Explains how to set up PC, 
Macintosh and Unix client 
workstations, for printing to the 
CXP6000 Color Server. 

Chapter 2 Reinstalling the System Explains how to reinstall your 
CXP6000 Color Server after a 
system crash, and guides you 
though the required procedures 
from reinstalling the operating 
system, to configuring your 
personal settings.

Chapter 3 Upgrading the Software Describes how to upgrade the 
CXP6000 Color Server Software 
Application by removing the 
previous version and reinstalling 
the new version.

Chapter 4 DFE Monitor Explains the provided 
information in the DFE Monitor 
view-only window.
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Conventions Used in This Guide
This section describes the fonts, terminology, and symbols used in this 
guide.

Fonts
Frutiger bold is used to refer to buttons and other items in a dialog box, file 
names, folders, menu names, and menu commands.

Minion Italic is used to refer to other chapters in the guide, book titles, and 
titles of other guides.

Frutiger is used for figure and table captions.

Letter Gothic is used for messages on your computer screen and for 
information that you must type.

SMALL CAPS is used for a key or key combination on your keyboard.

Chapter 5 Adding an External Device Provides a step-by-step 
procedure for adding an 
external disk to the CXP6000 
Color Server.

Appendix A Novell NDS Setup and 
Configuration

Describes how to configure the 
connection between a Novell 
NDS Server and the CXP6000 
Color Server, in a Novell 
working environment.

Chapter Contents Description
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Terminology

Clear Place the mouse pointer over the check box for the 
specified option, and click the left mouse button so 
that the X or check mark is removed from the check 
box.

Click Place the mouse pointer over the specified option or 
button and press and release the left mouse button.

Double-click Place the mouse pointer over the specified option or 
button and quickly press and release the left mouse 
button twice.

Drag Hold down the left mouse button while moving the 
mouse and release the button.

Press Press the specified key or key combination on your 
keyboard, for example, press CTRL+ALT+DEL.

Right-click Place the mouse pointer over an area of the 
application window, and then press and release the 
right mouse button to display the shortcut menu. For 
more information about using shortcut menus, see 
your Windows documentation.

Select Place the mouse pointer over the check box for the 
specified option, then click the left mouse button so 
that an X or check mark appears in the check box.

Or:

Place the mouse pointer over the specified box or 
button, and then click the left mouse button.

Type Type the information. Do not press the ENTER or 
RETURN key.
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Symbols

For More Information
Visit Creo at www.creo.com for documentation, training courses, 
downloads, and service and support contacts.

Important:  This symbol tells you about things that may cause process delays 
or reduce functionality, reliability, or quality.

Note:  A note provides additional information that you may need to consider.

Tip:  This symbol draws attention to information that can help you perform a 
task more quickly or easily.

The reference symbol tells you that related information on the topic is available 
in another CreoScitex document, or in another place in this guide.
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Default Network Printers on PC and Macintosh Clients 
For Macintosh and PC networks, the CXP6000 Color Server provides three 
default network printers, known as virtual printers.

Virtual printers contain preset workflows that are automatically applied to 
all print jobs processed with that virtual printer. There is no requirement 
to reset job settings for each job. This functionality results in greatly 
increased printing efficiency.

CXP6000 Color Server preset virtual printers:

• ProcessPrint 
Files sent to this printer are automatically processed and printed to the 
printer through the CXP6000 Color Server.

• ProcessStore 
Files sent to this printer are automatically processed and sent to the 
Storage Folder of the CXP6000 Color Server. You can later submit the 
jobs to be printed, or change the parameters of a job and resubmit it 
for processing.

• SpoolStore
Files sent to this printer are automatically stored in the CXP6000 Color 
Server's Storage Folder until the print operator submits them for 
processing and printing.

An additional default network printer is provided for Macintosh networks. 

• FontDownLoader
This is a special network printer used with Macintosh clients to 
download fonts. The FontDownLoader functions as a 
communications port, sending messages between the 
FontDownLoader program and the CXP6000 Color Server. It is not 
possible to send files via the FontDownLoader, only fonts.

The CXP6000 Color Server enables you to select which virtual printer to 
print to. It also allows you to define new virtual printers, with printing 
workflows tailored to your specific job requirements.

Note:  The job (print) parameters set in the job override the parameters set in the 
virtual printer.

For more information see Chapter 5, “Administrating the System” in the 
CXP6000 Color Server Printing Guide.
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Defining a Printer on PC Client Workstations
PC client workstations with the following operating systems installed, can 
print to the CXP6000 Color Server: Windows 98/ME and Windows NT 
4.0/2000 and XP. The CXP6000 Color Server network printers are defined 
using the Windows Add Printer Wizard - Network Printers. 

Defining a Printer - Windows NT 4.0

To define a CXP6000 Color Server Network Printer through the 
Windows Add Printer Wizard:

1. On your Windows desktop, click the Start button and follow the path 
Settings>Printers.

2. Double-click the Add Printer icon. 
The Add Printer Wizard appears.

3. Select Network Printer Server and click Next.

Note:  When adding a new CXP6000 Color Server network printer to a client 
workstation, there is no need to install the CXP6000 Color Server PPD and Adobe 
PS printer driver separately. They are installed automatically through the 
Windows Add Printer Wizard.
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4. Browse through the network for the CXP6000 Color Server and 
double-click the server name. 
A list of the network printers is displayed.

5. Select one of the network printers (for example, ProcessPrint), and 
click OK.

Note:  The CXP6000 Color Server is provided with three network printers: 
ProcessPrint, ProcessStore and SpoolStore.



Defining a Printer on PC Client Workstations 5

The following window appears.

6. If you want to set this printer as the default printer on your computer, 
select Yes. Otherwise, select No. 

7. Click Next.
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The following window appears.

8. Click Finish to complete the setup.
The CXP6000 Color Server network printer is now successfully 
installed. 

9. Repeat the above process to install additional network printers.

To define a CXP6000 Color Server Network Printer through the 
Network Neighborhood:

1. Browse to the required network printer.

2. Double-click the network printer icon.
A Printers message appears.

3. Click Yes to setup the printer.
The network printer is defined on your PC client workstation.

4. Repeat the above process to install additional network printers.

5. From the Printers list, select the CXP6000 Color Server and click Next.
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Defining a Printer - Windows 98

To define a CXP6000 Color Server network printer through the 
Windows Add Printer Wizard:

1. On your Windows desktop, click the Start button, and follow the path 
Settings>Printers.

2. Double-click the Add Printer icon. 
The Add Printer Wizard appears.

3. Click Next. 

Note:  When adding a new CXP6000 Color Server network printer to a client 
workstation, there is no need to install the CXP6000 Color Server PPD and Adobe 
PS printer driver separately. They are installed automatically through the 
Windows>Add Printer Wizard.
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The following window appears.

4. Select Network printer and click Next.
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The following window appears.
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5. Type the network path or the queue name of your printer. If you don’t 
know the exact name, click Browse to view the available network 
printers.

.

6. Select one of the network printers (for example, ProcessPrint).

7. Click OK.

8. Click Next. 
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The following window appears.

9. If you want to set this printer as the default printer on your computer, 
select Yes. Otherwise, select No. 

10. Click Next.
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The following window appears.

11. Select Yes to print a test page.
The CXP6000 Color Server network printer is now successfully 
installed. 

12. Click Finish to complete the setup.

13. Repeat the above process to install additional network printers.

To define a CXP6000 Color Server Network Printer through the 
network neighborhood:

1. Browse to the required network printer.

2. Double-click the network printer icon.
The Add Printer Wizard appears and the network printer is defined 
on your PC client workstation.

3. Repeat the above process to install additional network printers.
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Defining a Printer - Windows 2000 and ME

To define a CXP6000 Color Server network printer though the 
Windows Add Printer Wizard:

1. On your Windows desktop, click the Start button and follow the path 
Settings>Printers.

2. Double-click the Add Printer icon. 
The Add Printer Wizard appears.

3. Click Next. 

Note:  When adding a new CXP6000 Color Server network printer to a client 
workstation, there is no need to install the CXP6000 Color Server PPD and Adobe 
PS printer driver separately. They are installed automatically through the 
Windows Add Printer Wizard.
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The following window appears.

4. Select Network printer.

5. Click Next.
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The following window appears.

6. Select Type the printer name, or click Next to browse for a printer.

7. Type the exact name of the printer in the Name box.
Or:
Click Next to browse for a printer. 
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The following window appears.

8. Select one of the network printers (for example, ProcessPrint).

9. Click Next. 
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The following window appears.

10. If you want to set this printer as the default printer on your computer, 
select Yes. Otherwise, select No. 

11. Click Next. 
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The following window appears.

12. Click Finish to complete the setup.
The CXP6000 Color Server network printer is now successfully 
installed.

13. Repeat the above process to install additional network printers.

To define a CXP6000 Color Server network printer through Network 
Neighborhood:

1. Browse to the required network printer.

2. Double-click the network printer icon.
A Printers message appears.

3. Click Yes to setup the printer.
The network printer is defined on your PC client workstation.

4. Repeat the above process to install additional network printers.
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Defining a Printer - Windows XP

To define a CXP6000 Color Server network printer though the 
Windows Add Printer Wizard:

1. On your Windows desktop, click the Start button and follow the path 
Printers and Faxes.

Note:  When adding a new CXP6000 Color Server network printer to a client 
workstation, there is no need to install the CXP6000 Color Server PPD and Adobe 
PS printer driver separately. They are installed automatically through the 
Windows Add Printer Wizard.
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The Printer and Faxes window appears.

2. From the Printer Tasks, select Add a printer.
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The Add Printer Wizard appears.

3. Click Next.
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The Local or Network Printer window appears.

4. Select A network printer, or a printer attached to another computer 
and click Next.
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The Specify a Printer window appears.

5. Select Browse for a printer and click Next.
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The Browse for Printer window appears.
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6. Browse to the CXP6000 Color Server and double-click it to display the 
list of network printers.

7. Select the printer you wish to setup and click Next.
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The Default Printer window appears.

8. If you want to set this printer as the default printer on your computer, 
select Yes. Otherwise, select No. 

9. Click Next.
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The following window appears.

10. Click Finish to close the wizard.
The CXP6000 Color Server network printer is added to your printer 
list.

To define a CXP6000 Color Server network printer in Windows XP 
through the Network:

1. Browse to the required network printer.

2. Double-click on the network printer icon.
The network printer is defined on your PC client workstation.

3. Repeat the above process to install additional network printers.
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Creating PostScript Files on the PC
The following procedures describe how to create PostScript files using the 
CXP6000 Color Server from the client workstation. This is useful when 
you are not connected to the CXP6000 Color Server and you need to 
distribute jobs for printing on the CXP6000 Color Server remotely or on 
external media. These files can then be imported to the CXP6000 Color 
Server for printing.

To create a PostScript File:

1. Open a job in your DTP application (for example, Microsoft Word), 
and from the File menu, select Print.
The Print window appears.

2. Select the Print to File check box.

3. Click OK.
A PostScript file is now created.
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To define a Print to File printer locally:

1. Start the Adobe PostScript Driver application (the application is 
available on CD#3 in the Utilities folder, or at Adobe's Web site at 
www.adobe.com).
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The Welcome window appears.

2. Click Next.
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The End User License Agreement window appears.

3. Read the License Agreement and click ACCEPT.
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The following window appears.

4. Select It is directly connected to your computer (Local Printer), and 
click Next.
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The following window appears.

5. Select the FILE: Local Port and click Next.
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The following window appears.

6. Click Browse. 

Note:  The next step is to configure the printer with the CXP6000 Color 
Server PPD. The CXP6000 Color Server PPD (CXP6K3_6 for Xerox 
DocuColor 6060 and CXP6K3_2 for DocuColor 2060/2045) is located in a 
shared folder on the CXP6000 Color Server. 
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The Browse for Printer window appears.

7. Click the Network button and browse to your CXP6000 Color Server.
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The Map Network Drive window appears.

8. Locate the CXP6000 Color Server and double click on the server icon. 
Then, double-click the Utilities folder. 

9. Click OK.
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The Browse for Printer window appears.

10. Double click the PPD folder and select the CXP6000 Color Server 
PPD: CXP6K3_6.ppd.

11. Click OK.

Note:  This Spire PPD name is for Xerox DocuColor 6060. For DocuColor 
2060/2045 the PPD name is CXP6K3_2. 
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The following window appears.

12. From the Printers list, select the CXP6000 Color Server printer, and 
click Next.
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The following window appears.

13. Select Not Shared and click Next.
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The following window appears.

14. Type a name for the printer which you will be able to identify on the 
client workstation, for example CXP6000_ProcessStore. 

15. Select Yes (Recommended) if you want to print a test page or select 
No, then click Next.
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The following window appears.

.

16. Click Install to install the Print to file printer with the CXP6000 Color 
Server PPD. When prompted to configure the printer, click Yes and 
then click Next.
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The following window appears.

17. Select Yes.

18. Click Next.
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The Printer Properties window appears.

19. Configure the printer according to your specifications and then 
click OK.
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The following window appears.

20. Click Finish to complete the setup.
The printer appears in the Printers window.

You are now ready to print *.ps and *.prn files. Once printed, these files 
can be imported and printed on the CXP6000 Color Server.
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Copying PPD from PC
It is necessary to use the CXP6000 Color Server PPD to create PS files to 
send to the CXP6000 Color Server. The CXP6000 Color Server PPD 
should therefore be copied and distributed to the customer. 

To copy the PPD from the CXP6000 Color Server for distribution on a 
diskette or by e-mail:

1. On the Windows desktop, double-click the Network Neighborhood 
icon.

2. Browse to the location of the CXP6000 Color Server station (for 
example, CXP6000).

3. Select the CXP6000 Color Server and its Utilities folder.

4. Select the PPD folder.

5. Copy the CXP6K3_6.ppd file to a diskette or send it by e-mail to the 
customer.

Note:  This Spire PPD name is for Xerox DocuColor 6060. For DocuColor 
2060/2045 the PPD name is CXP6K3_2. 
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Defining a Printer on Macintosh Client Workstations
The CXP6000 Color Server can print to Macintosh client workstations 
running Macintosh OS 9 and OSX (10.2).

You can also submit jobs using the CXP6000 Color Server virtual printers 
over a TCP/IP protocol. This connection enables a significantly higher 
spooling speed.

See Spire Over TCP/IP on page 78

Setting the Network Printer for Macintosh OS 9

To set up a CXP6000 Color Server network printer on Macintosh OS 9:

1. From the Apple menu, select Chooser.

2. Select LaserWriter and browse through the network to the CXP6000 
Color Server.

3. Select one of the CXP6000 Color Server's network printers (for 
example, CXP6000_ProcessStore) and click Create.
The following status indicator appears.
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4. The system should automatically locate the CXP6000 Color Server 
PPD and configure the printer. If it does not, click Select PPD.

5. From the list of Printer Descriptions, select CXP6K3_6.ppd. 

6. Click the Select button.

Note:  This Spire PPD name is for Xerox DocuColor 6060. For DocuColor 
2060/2045 the PPD name is CXP6K3_2. 
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The printer is now set as a CXP6000 Color Server network printer. 

If you have the Desktop Printer Spooler extension enabled, a printer 
icon appears on the desktop.

7. Repeat the above process to install additional network printers.

Note:  This icon can be used when downloading PS files to the CXP6000 
Color Server.



Defining a Printer on Macintosh Client Workstations 49

Setting the Network Printer for Macintosh OS X (10.2)

To set up a CXP6000 Color Server network printer on Macintosh OS X:

1. From the Go menu, select Applications.

 

2. Open the Utilities folder.

3. Double-click the Print Center icon. 
The Printer List window appears.
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4. Click the Add Printer button.
The following window appears.

 

5. Select AppleTalk as the connection type.

6. Browse to the CXP6000 Color Server. 

Note:  If you would like to use the LPR protocol instead, see the procedure To 
Configure an LPR Printer on page 73.
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7. Open the Printer Model pop-up menu and select Other.
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8. Browse to the folder to which you have copied the CXP6K3_6.ppd and 
select it.

9. Click the Choose button to assign the CXP6K3_6.ppd to the selected 
CXP6000 Color Server network printer.

Note:  This Spire PPD name is for Xerox DocuColor 6060. For DocuColor 
2060/2045 the PPD name is CXP6K3_2. 
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The following window appears.

10. Click the Add button to add the new printer to the printer list.
The new printer is displayed in the Printer List window.
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LPR Printing with the CXP6000 Color Server
This section covers the procedures for setting up and configuring an LPR / 
TCP/IP printer from the following computers. 

• Windows NT 4.0 

• Windows 2000/XP 

• Windows NT/2000/XP Command Line 

• Mac OS X (10.2) 

• Mac OS 9 (using the Choose Spire Over IP utility) 

• Linux 

• AIX and UNIX command line 

Setting up an LPR Printer in Windows NT 4.0
The following procedure describes how to configure an LPR printer in 
Windows NT 4.0 for printing to the CXP6000 Color Server. 

 The following items must be installed and configured on the Windows NT 
4.0 computer (Server or Workstation version) before you begin: 

1. TCP/IP protocol
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2. Microsoft TCP/IP Printing service 

3. Latest Adobe PS Printer Driver (you can install this from the 
d:\utilties\Utilities\PC utilities on the CXP6000 Color Server, or you 
can download the latest version free from www.adobe.com).

4. CXP6000 PPD (PostScript Printer Driver) copied to your client 
workstation (the PPD is located in the d:\utilities\PPD\ folder on the 
CXP6000 Color Server).

To define an LPR Printer

1. From the Start menu on the Windows desktop, select 
Settings>Printers. 

http://www.adobe.com
http://www.adobe.com
http://www.adobe.com
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2. In the Printer window, from the File menu, select Server Properties. 

3. Select the Port tab, and then click the Add Port button. 

4. From the list of Available Printer Ports, select LPR Port, and click the 
New Port button. 

5. Type the exact name of the CXP6000 Color Server (this box is case-
sensitive), for example, OPAL5 in the Name or address of server 
providing lpd: box.
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6. Type the exact name of the network printer you want to print to (you 
can view the exact name of the printer on the CXP6000 Color Server, 
under: Admin>Resource Manager>Virtual Printers). In this example 
the Printer name is OPAL5_ProcessPrint.

7. Click OK.

8. Click Close in the Printer Ports window.  
The new LPR port is now defined on your computer.

9. Click OK in the Print Server Properties window. 

10. Define the LPR printer using the Adobe PostScript Printer driver 
application. See the following procedure.

To define an LPR Printer using the Adobe PostScript Driver:

1. Start the Adobe PostScript Driver Application (you can install this 
from the d:\utilties\Utilities\PC utilities on the CXP6000 Color Server, 
or you can download the latest version free from www.adobe.com).

2. In the Welcome window click Next. 

3. The End User License Agreement window appears, read the license 
agreement, and then click Accept.

http://www.adobe.com
http://www.adobe.com
http://www.adobe.com
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4. Select Install a new PostScript Printer, and then click Next. 

5. In the Printer Connection Type window, select It is directly connected 
to your computer (Local Printer), and then click Next.

6. Select the LPR port you defined earlier, for example, 
OPAL5_ProcessPrint LPR, and then click Next.

7. The next step is to configure the printer with the CXP6000 Color 
Server PPD (make sure that you have copied this to your computer, or 
that you have access to the CXP6000 Color Server on your network). 

8. In the Select Printer Model window, click Browse. 
The Browse for Printer window appears. 
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9. Locate the CXP6000 Color Server PPD, and then select the CXP6000 
Color Server PPD: CXP6K3_6.ppd. 

10. Click OK. 

11. In the Select Printer Model window, select the CXP6K3_6, and then 
click Next.

12. In the Sharing window, select Not Shared, and then click Next. 
The following window appears. 

13. Type a name for the printer that you will be able to identify on your 
computer, for example OPAL5_ProcessPrint LPR. You can also keep the 
original name of the printer. 

14. If you want to set this printer as the default printer on your computer, 
select Yes. Otherwise, select No.

15. Select Yes (Recommended) if you want to print a test page. Otherwise, 
select No. 
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16. Click Next. 

17. In the Setup Information window, click Install to install the LPR 
printer with the CXP6000 Color Server PPD. 

18. When prompted to configure the printer, click Yes. 

19. Click Next. 

20. In the Printer Configuration window, select Yes when prompted to 
configure the printer now. 

21. Click Next.
The CXP6000 Properties window appears. 

22. Configure the printer according to your specifications, and then click 
OK. 

23. In the Setup Complete window click Finish to complete the setup. 
The new LPR printer is now listed with your other printers on the 
Windows NT computer, and you are now ready to print to the 
CXP6000 Color Server using the LPR. 
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Setting up an LPR printer in Windows 2000/XP
The following procedure describes how to configure an LPR printer in 
Windows 2000/XP for printing to the CXP6000 Color Server.

The following items must be installed and configured on the Windows 
2000/XP computer before you begin:

1. TCP/IP protocol

2. Latest Adobe PS Printer Driver (you can install this from the 
d:\utilties\Utilities\PC utilities on the CXP6000 Color Server or you 
can download the latest version free from www.adobe.com).

3. CXP6000 PPD (PostScript Printer Driver) copied to your client 
workstation (the PPD is located in the d:\utilities\PPD\ folder on the 
CXP6000 Color Server). 

To define an LPR Printer

1. From the Start menu on the Windows desktop, select 
Settings>Printers.

2. In the Printer window, from the File menu, select Server Properties. 

 

http://www.adobe.com
http://www.adobe.com
http://www.adobe.com
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3. Select the Port tab, and then click the Add Port button. 

4. From the list of Available Printer Ports, select Standard TCP/IP Port, 
and then click the New Port button. 
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5. Click Next. 

6. Type the exact name of the CXP6000 Color Server (this box is case-
sensitive), for example, OPAL5 in the Printer Name or IP Address: box. 

7. Type a name for the printer that you will be able to identify on your 
computer, for example, OPAL5ProcessPrint LPR. 

8. Click Next. 
The following window appears. 
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9. Select Custom in the Device Type option, and then click Settings.

10. Select the following options:

• Protocol: LPR

• LPR Settings:

• Queue Name: Type the exact name of the network printer you 
want to print to (you can view the exact name of the printer on 
the CXP6000 Color Server, under: Admin>Resource 
Manager>Virtual Printers). In this example the Printer name 
is OPAL5_ProcessPrint

• LPR Byte Counting Enabled: checked. 
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11. Click OK, and then click Next. 
The following window appears. 

12. Click Finish. 

13. Click Close in the Printer Ports widow. 
The new Standard TCP/IP Printer Port is now defined on your 
computer.

 

14. Click Close in the Print Server Properties window. 



66  Chapter 1 – Setting Up Client Workstations

 

15. Define the TCP/IP Printer using the Adobe PostScript Printer Driver 
application. See the following procedure. 

To define an LPR Printer using the Adobe PostScript Driver:

1. Start the Adobe PostScript Driver Application (you can install this 
from the d:\utilties\Utilities\PC utilities on the CXP6000 Color Server, 
or you can download the latest version free from www.adobe.com).

2. In the Welcome window, click Next. 

3. The End User License Agreement window appears, read the license 
agreement, and then click Accept.

4. Select Install a new PostScript Printer, and then click Next. 

5. In the Printer Connection Type window, select It is directly connect to 
your computer (Local Printer), and then click Next.
The following window appears.

6. Select the Standard TCP/IP port you defined earlier on, for example, 
OPAL5_ProcessPrint LPR, and then click Next.

7. The next step is to configure the printer with the CXP6000 Color 
Server PPD (make sure that you have copied this to your computer, or 
that you have access the CXP6000 Color Server on your network). 

8. In the Select Printer Model window, click Browse. 
The Browse for Printer window appears. 

http://www.adobe.com
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9. Locate the CXP6000 Color Server PPD, and then select the CXP6000 
Color Server PPD: CXP6K3_6.ppd. 

10. Click OK. 

11. In the Select Printer Model window, select the CXP6K3_6, and then 
click Next.

12. In the Sharing window, select Not Shared, and then click Next. 

13. Type a name for the printer that you will be able to identify on your 
computer, for example, OPAL5_ProcessPrint LPR. You can also keep 
the original name of the printer. 

14. If you want to set this printer as the default printer on your computer, 
select Yes. Otherwise, select No.

15. Select Yes (Recommended) if you want to print a test page. Otherwise, 
select No. 



68  Chapter 1 – Setting Up Client Workstations

 

16. Click Next. 

17. In the Setup Information window, click Install to install the LPR 
printer with the CXP6000 Color Server PPD. 

18. When prompted to configure the printer, click Yes. 

19. Click Next. 

20. In the Printer Configuration window, select Yes when prompted to 
configure the printer now. 

21. Click Next.
The CXP6000 Properties window appears.

22. Configure the printer according to your specifications, and then click 
OK. 

23. In the Setup Complete window, click Finish to complete the setup.
The new LPR printer is now listed with your other printers on the 
Windows NT computer, and you are now ready to print to the 
CXP6000 Color Server using the LPR.
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Windows NT/2000/XP Command Line
You can also submit PostScript, PDF or VPS files for printing to the 
CXP6000 using the following commands in the Window command line. 
The following procedure is suitable for Windows NT, 2000, or XP 
computers. 

 

1. From the Start menu, click Run. 

2. Type cmd, and then click OK. 

3. Locate the directory that contains the file(s) you want to print. 

4. Type the following at the command line (all commands, server name, 
and printer name are case-sensitive):
lpr –S <server name> -P <virtual printer name> -ol 
<file name>  
and then press ENTER.
For example:
lpr –S OPAL3 –P OPAL3_ProcessPrint –ol brochure.ps

Your file is printed to the CXP6000 Color Server using the LPR 
command.

Note:  All PostScript files should be created using the CXP6000 Color Server PPD 
(CXP6K3_6.ppd)
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Setting up an LPR printer in Mac OS X (10.2) 
Before you define a network printer you need to install the CXP6000 Color 
Server PPD to your Macintosh.

Copying the Spire PPD

To copy the CXP6000 PPD:

1. From the Go menu, select Connect to Server.

The Connect to Server window appears.

2. Browse to the required CXP6000 Color Server.

3. Click the Connect button.
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The following window appears.

 

4. Select Guest and click the Connect button.

The following window appears.

 

5. Select the CXP6000_Utilities folder, and click OK.
The CXP6000_Utilities folder is mounted on your desktop.

6. Double-click the CXP6000_Utilities folder on your desktop.
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7. Double-click the PPD folder.

 

8. Copy the CXP6K3_6.ppd from the CXP6000 Color Server to your 
Macintosh hard disk.

Tip:  It is recommended that you copy the PPD by dragging and dropping 
from the CXP6000 Color Server to the Library>Printers>PPDs folder on your 
Macintosh.

Note:  This Spire PPD name is for Xerox DocuColor 6060. For DocuColor 
2060/2045 the PPD name is CXP6K3_2. 
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Configuring an LPR Printer

To configure an LPR Printer:

1. Follow the procedure “To set up a CXP6000 Color Server network 
printer on Macintosh OS X” on page 49, until step 5.

2. In the Printer List window, select LPR Printers using IP as the 
connection type.

3. In the LPR Printer's Address box, type the TCP/IP address or 
hostname of the CXP6000 Color Server. See the following example.

4. Clear the Use Default Queue on Server check-box.
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5. In the Queue Name box, type the full name of the CXP6000 Color 
Server network printer, for example CXP7_ProcessPrint (case-
sensitive).

6. From the Printer Model pop-up menu, select Other.

7. Browse to the folder to which you have copied the CXP6K3_6.ppd and 
select it.

 

8. Click the Choose button to assign the CXP6K3_6.ppd to the selected 
CXP6000 Color Server network printer.
The following window appears.
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9. Click the Add button to add the new printer to the printer list.
The new printer is displayed in the Printer List window.

Setting up an LPR printer in Mac OS 9 (using the Choose Spire Over IP utility)
Before setting up a CXP6000 Color Server network printer, you need to 
install the CXP6000 Color Server PPD on the Macintosh workstation. 

Copying the Spire PPD

To copy the CXP6000 Color Server PPD:

1. From the Apple menu, select Chooser.

2. Select AppleShare and browse the network to where the CXP6000 
Color Server is configured.
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3. Select the CXP6000 Color Server (for example CXP6000), and click 
OK.

The Login window appears.

4. Log in as Guest, and click the Connect button.
The corresponding CXP6000 Color Server window appears.
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5. Select the Utilities folder and click OK.

6. Select the Utilities volume located on the desktop and click OK.

7. Select the PPD folder.

8. Copy the CXP6K3_6.ppd file to the System Folder>Extensions>Printer 
Descriptions folder.
The CXP6000 Color Server PPD is now installed in the Printer 
Descriptions folder. It is ready to be configured with one of the 
CXP6000 Color Server's network printers. 

Note:  Do not select the check box, otherwise it will mount with every 
reboot.

Note:  This Spire PPD name is for Xerox DocuColor 6060. For DocuColor 
2060/2045 the PPD name is CXP6K3_2. 
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Spire Over TCP/IP
The Spire Over TCP/IP application enables Macintosh clients to submit 
jobs using the CXP6000 Color Server virtual printers over a TCP/IP 
protocol. This connection enables a significantly higher spooling speed.

To install this application, you will require a Macintosh O/S version 8.6 or 
higher, with an installed LaserWriter application version 8.6 or higher, or 
AdobePS 8.8 or higher (available at http://www.adobe.com). If you do not 
have a compatible LaserWriter application installed, you may download 
this application from the CXP6000 Color Server, under D:\Utilities\Mac 
utilities folder.

To install the Choose Spire Over IP application:

1. On your Macintosh client workstation, from the Apple menu, select 
Chooser.
The Chooser window appears.

2. Select AppleShare and browse the network to the required CXP6000 
Color Server (for example Falcon_Color) and click OK.
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The Login window appears.

3. Select Guest and click the Connect button.
The corresponding CXP6000 Color Server window appears.
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4. Select the Utilities folder and click OK.
The Utilities folder icon appears on your desktop; double-click it to 
open the folder.

5. Double-click the Choose Spire Over IP Installer icon.

6. Click the Install button.
After the installation is complete, the following message appears.
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7. Click Quit.
The Choose Spire Over IP option is now added to the Apple menu.

8. To create desktop printers for printing over IP, from the Apple menu, 
select Choose Spire Over IP.

9. To view the print queues of the CXP6000 Color Server, double-click 
the Local Services and then double-click the CXP6000 Color Server 
icon (in this example FALCON_COLOR).

10. To create a desktop printer for a specific print queue, select the print 
queue from the list (for example FALCON_COLOR_Process Print) and 
click the Setup button. 
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The following window appears.

11. Select the Select a PPD file on this computer option and click OK.
The following window appears.

12. Browse to the CXP6000 Color Server PPD file, that you have copied to 
your computer in step 1, select it and click Open.

The following window appears.

Note:  This Spire PPD name is for Xerox DocuColor 6060. For DocuColor 
2060/2045 the PPD name is CXP6K3_2. 



LPR Printing with the CXP6000 Color Server 83

13. If you would like to change the printer name you may. Otherwise, 
click OK.
The desktop printer is created and configured and the following 
progress indicator appears.

When the printer is successfully created, the following message 
appears.

14. Click OK.
The printer icon appears on your desktop.

15. You may now print your jobs using this printer through a TCP/IP 
protocol.
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Printing to the Linux
The following procedure describes how to print from Linux to the 
CXP6000 Color Server using the command line or by defining a printer 
using the Linux user interface (in this case Red Hat Linux). 

Linux Command Line
1. Open a Terminal window (System Tools>Terminal Window). 

2. If your Linux computer is not configured with DHCP in the network 
settings, you will need to add the hostname and TCP/IP address of the 
CXP6000 Color Server that you want to print to in the /etc/hosts file. 

Note:  You do not need to use the CXP6000 Color Server PPD 
when printing from Linux.
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Browse to the directory that contains your file(s), and then type the 
following command (all commands and printer name are case-sensi-
tive). The server name is the name defined in the /etc/hosts file or as 
the registered name in the DNS server on your network (DHCP use):
# lpr –P <virtual printer name>@<server name> <file-
name>
For example:

# lpr –P OPAL3_ProcessPrint@opal3 letter.ps

3. Press ENTER. 
Your file is then printed to the CXP6000 Color Server. 

Linux user interface
The following procedure reflects Red Hat Linux version 8.0

1. Select System Settings>Printing.
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2. Click New to add a setup a new LPR/LPD printer. 

3. In the Add A New Print Queue window, click Forward.

4. In the Set the Print Queue Name and Type window, type a name for 
the printer that you will be able to identify on your computer, for 
example, OPAL3_LPR.

5. Click Forward. 
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6. In the Configure a Unix Print Queue window, type the CXP6000 
Color Server server name in the Server: box, for example, OPAL3. In 
the Queue box, type the exact name of the network printer you wish 
to print to (you can view the exact name of the printer on the 
CXP6000 Color Server, under Admin>Resource Manager>Virtual 
Printers). In this example the Printer name is OPAL3_ProcessPrint.

7. Click Forward. 

8. In the Select a Printer Driver, select the PostScript Printer, and then 
click Forward. 
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9. In the Finish, and Create the New Print Queue window click Apply.

10. In the Red Hat Printer Config window, click Apply. 

11. When prompted, click OK.
The new LPR/LPD printer is now listed with your other printers on 
the Linux computer and you are now ready to print to the CXP6000 
Color Server using the LPR/LPD.
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Defining a Printer on Unix Client Workstations

AIX and UNIX Command Line

To define an AIX 4.2.1 printer for printing through LPR:

1. On your UNIX workstation (for example, AIX 4.2.1), type SMIT and 
follow the sequence: Print Spooling>Add a Print Queue> 
remote>Standard processing.

2. In Name of QUEUE to add, type the name of the print queue to be 
used on your UNIX client (use a logical name to recognize the remote 
printer).

3. In HOSTNAME of remote server, type the hostname of the remote 
server where the printer is defined (for example CXP6000).

4. In Name of QUEUE on remote server, type the exact name of the print 
queue defined on the remote server (for example ProcessPrint).

5. Click OK.

Printing from a UNIX Client Workstation

To print from a UNIX client through LPR:

1. Type the following:
<lpr><space><-P><space><local UNIX printer
name><space><PS file name>
For example, to print frog.ps on a printer named ProcessPrint, type:
lpr -P ProcessPrint frog.ps.

2. Press ENTER.
The PostScript file is downloaded to the printer. All settings are taken 
from the remote printer on the CXP6000 Color Server.

Note:  Verify that the printer name defined on the remote server contains no 
more than 20 characters. Unix is case sensitive.

Note:  Use alphanumeric and underscores for names. Names 
are case sensitive, for example, ProcessPrint not processprint. 
UNIX does not require PPDs to print jobs.
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Overview
This chapter describes the two methods of reinstalling your CXP6000 
Color Server software by complete overwrite or by system partition. It 
describes how to install the Windows 2000 Professional operating system, 
the Creo Software Application, and to configure the system using the 
Configuration Wizard.

The CXP6000 Color Server is delivered to the customer site preloaded with 
the following software and configuration:

• Windows 2000 Professional

• MS Service Pack 3.0

• Internet Explorer 6.0

• CXP6000 Color Server version 3.0 for the DocuColor 6060

• Adobe Acrobat 5.0

• Ultimate InSpire Software

• Network Parameters (hostname, IP address, network services and 
protocols)

It may, however, become necessary, for example after a system crash, to 
reinstall the system at the customer’s site.

The reinstallation is mostly unattended. User interaction is needed only for 
entering the OS license number and the computer hostname, for rebooting 
the computer when requested, for inserting the final application CD-ROM 
and for the Configuration Wizard. The reinstallation of the system requires 
two CD-ROMs: CD-ROM #1 (Windows 2000 Professional Fast Install) 
and CD-ROM #2A (CXP6000 Color Server version 3.0 for the DocuColor 
6060 Application Software) or CD-ROM #2B (CXP6000 Color Server 
version 3.0 for the DocuColor 2060/2045 Application Software).

Notes:

System Partition Overwrite should be performed when the Windows 2000 
Professional operating system is corrupt and needs to be reinstalled.

Complete Overwrite should be performed only when installing a new system.

If you are installing a new system, or you are replacing any SCSI hard disk, it is 
recommended to perform low-level formatting (see the CXP6000 Color Server 
Technical Manual for details).
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The following table outlines the CXP6000 Color Server disk configuration:

There are two methods of reinstalling the system:

• Creo Software Complete Overwrite Installation: 
This procedure replaces the entire system disk, operating system 
partition, Creo application, and user partition (partitions C: and D:). 
A complete overwrite should be performed only when you are 
upgrading the operating system.

• Creo Software Preservation Installation (System Partition Overwrite): 
This procedure replaces only the operating system partition (C:). You 
should perform System Partition Overwrite when the Windows 2000 
Professional operating system is corrupt and needs to be reinstalled.

Disk 0 C: 
Windows 2000 Professional 
software
Creo application

 D: 
Spool files
Shared files
Output directory files
Apr high res files

Disk 1 Image storage

Disk 2 Image storage

Notes:

To enable the restoration of customer settings, back up the CXP6000 Color 
Server configuration, before loading the operating system.

It is recommended that you back up your configuration on a diskette in case the 
system crashes.

Determine whether VIPP or any other Xerox/Creo supported application is 
loaded on the CXP6000 Color Server. Such applications have to be reloaded 
after the reinstallation is completed.

Note:  This option deletes all the files stored on disks C: and D:. Make sure to 
back up any important customer files before selecting this option.
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Reinstalling the Operating System
Before reinstalling, ensure that:

• all external SCSI devices are disconnected from the CXP6000 Color 
Server.

• the following information is available

• CD-ROM software pack

• Computer name (for example, CXP1)

• TCP/IP information

• Windows 2000 Professional OEM product ID number

• Gateway, WINS address, and DNS information

• Required AppleTalk zone

• IPX information

To reinstall the Windows 2000 Professional operating system:

1. Power on your computer.

2. Place CD-ROM #1 (Windows 2000 Fast Install) in the 
CD/DVD-ROM drive.

3. Restart the computer. 

4. On the desktop, follow the path: Start>Shut Down>Restart.

5. Wait until the PC DOS Start Up Menu appears. 
The following choices are available:

• Creo Software Complete Overwrite Installation

• Creo Software Preservation Installation (System Partition 
Overwrite)

• DOS prompt

For more details, refer to the Xerox Installation and Planning Guide.

Note:  If you are already logged on your system and the CXP6000 Color Server 
workspace is open, exit the workspace and proceed to step 2.
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6. Use the arrows to select Creo Software Complete Overwrite 
Installation and press ENTER.

The system starts copying the files.
After a few minutes, you are prompted to remove the CD-ROM from 
the CD/DVD-ROM drive and reboot.

7. Press CTRL+ALT+DEL to reboot.
The system copies files and reboots a few times.

8. When the Windows 2000 Professional Setup screen appears type the 
25-digit Product Key, that comes with the Windows 2000 Professional 
manual, and click Next.

9. In the Computer Name and Administrator Password screen, type the 
name for the CXP6000 Color Server, for example CXP6000_1.

10. Click Next.
The installation process begins.

11. At the end of the installation, the system reboots a number of times. 
You are asked to insert the Application Software CD-ROM 
(CD-ROM #2A or #2B) into the CD/DVD-ROM drive.

12. Proceed to Reinstalling the Creo Application Software on page 96.

Note:  If the Norton Ghost® License Agreement Warning appears, select OK 
to mark the drives as usable by Norton Ghost.
The warning will only appear if you have installed a new SCSI hard disk.

Important:  In the administrator name and password area, use the default 
settings. If required, you can change the administrator name and password, but 
only at the end of the installation process (see If you want to change the 
administrator name and password: on page 133, or If you want to change the 
user password: on page 133).
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Reinstalling the Creo Application Software

To reinstall the Creo application software:

1. Select the correct CD-ROM #2 for your printer type.

2. Insert the CD-ROM into the CD/DVD-ROM drive and close the 
CD/DVD-ROM drive. 

3. In the SPIRE splash screen that appears, click Start.
The Adobe Acrobat setup begins.

4. After the Adobe Acrobat setup is complete, the CXP6000 Color Server 
installation starts.

5. When the License Agreement window opens, click Yes to continue the 
CXP6000 Color Server installation.

6. When the installation is complete, remove CD-ROM #2 from the 
CD/DVD-ROM drive.

7. The system restarts automatically. 
Proceed to Disk Striping on page 97.
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Disk Striping

To stripe the disks:

1. Once the CXP6000 Color Server reboots the Wrong Disk 
Configuration message appears. This message indicates that the disks 
need to be striped. Click OK.

The Disk Management window appears.

2. Maximize the window.
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3. In the Disk Management window, check whether Disk 1 and Disk 2 
are Dynamic or Unknown.

• If the disks are Dynamic perform the procedure: To stripe Dynamic 
disks: on page 99.

• If the disks are Unknown perform the procedure: To stripe 
Unknown disks: on page 103.

Check whether the disks are
Dynamic or Unknown
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To stripe Dynamic disks:

1. Position the cursor in the area where the disk is designated Dynamic.
Right-click and select Import Foreign Disk.

The following window appears.

2. Verify that Foreign disk set (2 of 2 disks selected) is selected and click 
OK. 

Foreign disks are SCSI hard disks that were recognized as dynamic disks 
from a previous installation.

Cursor
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The following window appears.

3. Click OK. 
The Dynamic disks are striped as shown in the following window.
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4. Position the cursor in the white area to the right of the first disk
and right-click.
Select Change Drive Letter and Path.

The following window appears.

5. The drive letter is preselected. 
Click Remove.

Cursor
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The following Confirm message appears.

6. Click Yes.

7. Confirm that the Disk Management window appears as illustrated in 
the following window, which shows that the drive letters have been 
removed.
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8. Close the Disk Management window.

9. The Image Disks File System is not Formatted message appears. 
Click OK.

10. You have completed to stripe the Dynamic disks.

• If configuration recovery information is available, proceed to The 
Configuration Wizard (If Backup Available) on page 114.

• If there is no backup and the system configuration must be done 
manually, proceed to The Configuration Wizard If Recovery Fails or 
is Unavailable on page 119.

• If the system recognizes a SCSI hard disk that is new or a disk that 
has been low-level formatted perform the following procedure To 
stripe Unknown disks:.

To stripe Unknown disks:

1. Position the cursor in the area where the disk is designated Unknown.
Right-click and select Write Signature.

Cursor
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The following window appears.

2. Select the Disk 1 and Disk 2 check boxes and click OK.

3. In the Computer Management screen, Disk 1 and Disk 2 are now both 
designated Basic.
Position the cursor in the area where the first disk is designated Basic.
Right-click and select Upgrade to Dynamic Disk.

Cursor
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The following window appears.

4. Select the Disk 1 and Disk 2 check boxes and click OK. 
Disks 1 and 2 are image disks and Disk 0 remains a system disk.

Note:  Do not select Disk 0. Upgrading Disk 0 will remove all the information 
stored on this disk.
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5. In the Computer Management window, Disk 1 and Disk 2 are now 
both designated Dynamic.
Position the cursor in the cross-hatched area to the right of the first 
disk.
Right-click and select Create Volume.

The following wizard appears.

6. Click Next.

Cursor
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The following window appears.

7. Select Striped volume and click Next.
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The following window appears.

8. Select Disk 2 and click Add>>.
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The following window appears.

9. Disk 1 and 2 are listed under Selected dynamic disks. The Total 
volume size has increased from 35001 MB to 70002 MB. 
Click Next.
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The following window appears.

10. Select Do not assign a drive letter or drive path.
Click Next.
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The following window appears.

11. Select Do not format this volume and click Next.
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The following window appears listing a summary of disk and striping 
information.

12. Click Finish.
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The following window appears.

13. Confirm that the Disk Management window appears as illustrated in 
the previous window: one of the volumes is cross-hatched, and the 
drive letters have been removed.

14. Close the Disk Management window.

15. The Image Disks File System is not Formatted message appears. 
Click OK.
The CXP6000 Color Server reboots automatically.

16. After the computer restarts, the Configuration Wizard appears.

• If configuration recovery information is available, proceed to The 
Configuration Wizard (If Backup Available) on page 114.

• If there is no backup and the system configuration must be done 
manually, proceed to The Configuration Wizard If Recovery Fails or 
is Unavailable on page 119.
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The Configuration Wizard (If Backup Available)
The CXP6000 Color Server Configuration Wizard automatically appears 
after the installation is complete. Follow the steps of the wizard to complete 
the CXP6000 Color Server configuration recovery.

Note:  If you received the message Error in default configuration, 
click OK and go to step 2 in Restoring the Configuration on page 115.
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Restoring the Configuration

To restore the configuration:

1. If you would like to restore the default configuration, select Default 
Configuration.

2. If you received the message "Error in default configuration", or if you 
want to use a different configuration file than the default, choose 
Select Configuration and click Browse. 

3. Locate the required configuration file and then click OK.



116  Chapter 2 – Reinstalling Your CXP6000 Color Server

 

4. Click the Start Recovery button.
The Restore Configuration dialog box appears.

5. By default, all categories are selected. If you do not want to restore 
certain categories, clear the required selections.

6. Click OK.
The following message appears.

7. Click Yes if you would like the restored files to replace the current 
ones. Click No if you do not want the restored files to replace the 
existing files.
After the recovery is complete, a confirmation message is displayed.

8. Click OK.

Note:  When restoring the configuration all the custom tables/sets will be 
added to the system, for example, imported user-defined imposition 
templates, new virtual printers, downloaded fonts etc.
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9. Click Next in Step 2 Recovery window.
The View Configuration window appears.
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10. Click Close to exit the View Configuration window.
Step 9 of the Configuration Wizard appears.

11. Click Finish.
The CXP6000 Color Server Application workspace appears on your 
screen.

12. Close all open applications and from the Start menu, choose 
Shutdown. Then, select Restart the Computer, and click Yes. The 
CXP6000 Color Server restarts.

13. If you want to change the administrator name and password, or only 
the user password, proceed to If you want to change the administrator 
name and password: on page 133, or If you want to change the user 
password: on page 133.
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The Configuration Wizard If Recovery Fails or is Unavailable
If there is no backup configuration in your system, you need to perform 
the following steps to configure your system.

Choosing the Configuration Type
The CXP6000 Color Server Configuration Wizard automatically appears 
the first time you power on the CXP6000 Color Server. 

To choose the configuration type:

Verify that First Time Configuration is selected and click Next.

Setting the Language 

To set the language:

Select the required interface language, and click Next.
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Configuring the Host Name
The CXP6000 Color Server contains a default Computer Name 
(Hostname) set from the factory. Check with your System Administrator if 
the computer’s name needs to be changed.

To configure the host name:

1. Verify that the correct host name is displayed and click Next. 
Otherwise, click the Change button.

Note:  The Hostname is taken from the computer name you typed during the 
Windows 2000 Professional Fast Installation, see Reinstalling the Operating 
System on page 94.
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The System Properties dialog box appears.
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2. Click the Properties button.
The Identification Changes window appears.

3. In the Computer name field, type the new name for the computer. If 
you would like to change the Workgroup or the Domain in which your 
computer appears, type the new name in the corresponding field and 
click OK.

A message appears to inform you that changes will take effect only 
after reboot.

4. Click OK.

5. Click OK also in the System Properties dialog box.

Note:  Do not change the Workgroup or Domain unless instructed. If you are 
changing the Domain / Workgroup, verify that you have the user name and 
password for the Domain/ Workgroup.
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6. Click Next to continue.

Setting the Date and Time

To set the date and time:

1. Check that the Date and Time are set correctly and click Next. 
Otherwise, click the Change button.

Note:  When prompted to restart your computer, click No, (since you will be 
prompted at the end of the Configuration Wizard to restart your system).
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The Date/Time Properties dialog box appears.

2. Set the Time Zone and click OK.

3. Set the Date and Time correctly and click OK.

4. Then click Next.
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Setting the Default Measurement Units

To set the default measurement units:

Select the default measurement unit you want to use, and click Next.
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Configuring the IP Address

To set the IP address:

1. The CXP6000 Color Server is set to DHCP server configuration.
Click Next to continue.

2. If you would like to specify a specific IP address, click the Change 
button.
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The Local Area Connection Properties dialog box appears, followed by 
the Internet Protocol (TCP/IP) Properties dialog box.

3. Select Use the following IP address and type the IP address, Subnet 
mask and Default gateway in their corresponding boxes.

4. Click OK.

5. Click OK also in the Local Area Connection Properties dialog box.

6. Click Next.

For more details on how to get the IP or DHCP (also subnet mask and 
default gateway) information, refer to the Xerox Installation and Planning 
Guide.
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Configuring the Apple Talk Zone
This option enables you to change the AppleTalk network zone that your 
CXP6000 Color Server will appear in.

To select an AppleTalk zone:

1. Click the Change button. 

Note:  This option only applies to networks that contain Macintosh computers.
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The Local Area Connection Properties dialog box appears, followed by 
the AppleTalk Protocol Properties dialog box.

2. Select the required zone from the list and click OK.

3. Click OK also in the Local Area Connection Properties dialog box.

4. Click Next.
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Completing the Configuration

To complete the configuration:

1. After the configuration is complete, the View Configuration window is 
displayed.
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2. Click Close.
The following window appears.

3. Click Finish to complete the First-time setup.
When the backup is complete, the following message appears.

4. Click OK.
The CXP6000 Color Server workspace appears on your screen. 
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5. If you want to change the administrator name and password:

a. On the Windows desktop, right-click My Computer and select 
Manage.

b. Expand the Local Users and Groups tree, and select Users.

c. Select Administrator. Right-click and select Properties.

d. Type the Full name and click OK.

e. Select Administrator. Right-click and select Password.

f. Type and confirm the new password and click OK.

6. If you want to change the user password:

a. Press CTRL+ALT+DELETE.

b. In the Windows Security window, click Change Password.

c. Type the old and new password and confirm the new password.

d. Click OK.

7. If you have a Novell network running IPX protocol, proceed to 
Installing and Configuring Novell Client for Spire on page 133. 

Installing and Configuring Novell Client for Spire
The following procedures are only relevant for those customers who have 
a Novell network running IPX protocol.

Installing Novell Client for Spire

To install Novell Client for Spire:

1. Close the Spire workspace and the Spire application.

2. Close all other applications.

Note:  Further information about configuring the connection between the 
CXP6000 Color Server and a Novell NDS server, in a Novell working environment, 
is provided in Appendix A, Novell NDS - Setup and Configuration.
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3. On the Windows Start, click Start and follow the path, 
CXP6000>CXP6000 Tools>Novell Client Installation.

The following window appears.
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4. Click Install.
The following window appears.

5. Click Reboot.

6. You have completed Installing Novell Client for Spire. Proceed to 
Configuring Novell Client for Spire on page 136.
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Configuring Novell Client for Spire

To configure Novell Client for Spire:

1. After the system reboots, the Novell Setup window appears.

2. Type the Tree Name. 
If you do not know the name, click Browse.
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The following window appears.

3. Double-click the appropriate Tree Name.
The Tree Name appears in the Novell Setup window.

4. Type the Context Name. 
If you do not know the name, click Browse.
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The following window appears.

5. Double-click the appropriate Context Name.
The Context Name appears in the Novell Setup window.

6. Click OK.
The Spire workspace appears. 

Uninstalling Novell Client for Spire
Uninstall Novell Client for Spire if you no longer operate a Novell network 
running IPX protocol.

To uninstall the Novell Client for Spire:

1. Close the Spire workspace and the Spire application.

2. Close all other applications.

3. Right-click My Network Places and select Properties.

4. Right-click Local Area Connection and select Properties.
The following window appears.
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5. Clear the Novell for Client for Windows check box.

6. Make sure that Novell for Client for Windows is selected, and click the 
Uninstall button.

7. Click Yes twice.
The CXP6000 Color Server reboots.
You have completed Uninstalling Novell Client for Spire.
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Software Upgrade

To update the software:

1. Before you begin upgrading the CXP6000 Color Server software you 
should backup your current configuration.

2. Exit the Creo Software Application from the Job menu select Exit, and 
then wait for the Creo icon to disappear from the windows task bar on 
the right hand side.

3. Before updating the system to a new version, removal of the current 
version is required. From the Start menu, select Settings > Control 
Panel and then double-click on the Add/Remove Programs icon.

4. Select the CXP6000 icon and then click Change/Remove button.
The following confirmation message appears.

5. Click Yes.
The Uninstall Shield appears.

Note:  This section does not reload the operating system, if you need to reload 
Windows 2000 Professional, see Reinstalling the Operating System on page 94 
for details.

Note:  When prompted to remove certain files select Yes to all.
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At the end of the removal procedure, the following window appears.

6. Click OK.
The following message appears. 

7. Click OK.

8. Click Close to close the Add/Remove Programs window.

9. Close the Control Panel window.

10. From the Start menu, select Shutdown > Restart. Then, click OK to 
confirm your choice.
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11. Once the CXP6000 Color Server has rebooted insert the CXP6000 
Color Server Application Software CD#2.

12. Locate the Setup.exe file and double-click this file to run Setup. If a 
Services or driver fail message appears, click OK.

13. Click Yes to the accept the licence agreement. 

14. Click Yes if any other messages appear.

15. When the setup is complete, click Finish to reboot the CXP6000 Color 
Server. 

The Software upgrade is now complete.
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General Information
The DFE Monitor dialog box provides general information about the 
following:

• Disk usage 

• Network setup

• Virtual printers

Access this view-only window by clicking on the DFE Animation on the 
CXP6000 Color Server workspace Status panel.

Disk Usage
In the Disk Usage tab, you can receive on-line visual statuses for disk 
capacity and disk usage.

Disk usage displays the usage of both User and Image disks. 

For each disk, the following data is displayed: 

• Used disk space

• Free disk space

• Threshold level for each disk
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Network
The Network tab enables to view the network details.

The following details are available:

• Host name and Domain

• IP address and whether DHCP server is enabled or not

• Apple Talk zone

• IPX Setup and Printing (tree and context)
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Virtual Printers
The Virtual Printers tab enables to view the defined virtual printers and 
also indicates if these are published on the network.
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Adding an External Device

Connecting the External Device to the CXP6000 Color Server
This section describes how to connect the cables from the external device 
to the CXP6000 Color Server.

To connect an external SCSI device:

1. Shut down the CXP6000 Color Server.

2. Connect the external SCSI cable to the external SCSI port on the left 
of the server (see the following figure).

Notes: 
The added external device can be used for saving files but not for the Creo 
application itself.

It is preferable to remove the Creo application prior to the installation and then 
reinstall it after the installation is complete.

Important:  Do not use the external SCSI port on the right of the server.
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3. Verify that the device is defined as ID1 or higher.

4. Turn the external device’s power on.

Initializing the External Device
This section describes how to initialize the external device.

To initialize the external device:

1. Turn the CXP6000 Color Server’s power on and wait for the operating 
system to initialize.

2. On your Windows desktop, right-click My Computer, and from the 
menu select Manage.
The Computer Management window appears.

3. From the tree on the left pane, select Disk Management.
The disk space area appears in the Computer Management window.
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The gray background in the disk space area, opposite Disk 3 
Removable, indicates that the new external device is not located or not 
formatted.

Formatting the External device
This section describes how to format the external device, if the CXP6000 
Color Server has not located the device, or has identified that the device 
has not been formatted.

To format the external device:

1. On the Windows desk top, select My Computer and right-click 
Removable Disk (F:).

2. From the menu select Format.
The Format F:\ window appears.

Note:  If there is a blue background, similar to the disk space area opposite 
Disk 0 in the previous illustration, the device is located and formatted. 
Proceed to step 8 in Formatting the External device on page 152.
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3. Select the Format options you require and click Start.

4. After the formatting is complete, click OK.

5. Click Close.
The Formatting Complete message appears.

6. Click OK and then click Close.

7. On your Windows desktop, right-click My Computer, and from the 
menu select Manage.

8. From the tree on the left pane, select Disk Management.
The following window appears.

In the previous window, the external SCSI device appears as Disk 3 
Removable, with the drive letter (E:).

Note:  Verify that the drive letter of the added Disk is other than C, D or E 
(these letters should be used for the System). If the drive letter is C, D or E, 
change the assigned drive letter. See Changing the External Device Drive 
Letter on page 154.



154  Chapter 5 – Adding an External SCSI Device

 

Changing the External Device Drive Letter
This section describes how to change the external device drive letter if the 
drive letter is incorrect.

To change the external device drive letter:

1. In the Computer Management window, select Disk Management.

2. The Wrong Drive Letter message appears. Click OK.

3. Position the cursor in the white area opposite Disk 1 Removable and 
right-click.

Cursor
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The following window appears.

4. Select Change Drive Letter and Path.
The following window appears.

5. Click the Edit button. 
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The following window appears.

6. Assign a drive letter (not C, D, or E) and click OK.

7. Click Yes to confirm the changed drive letter.
The following window appears showing the changed drive letter.
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Changing the CD/DVD-ROM Drive Letter
This section describes how to initialize the external device as the CD/DVD-
ROM drive letter is incorrect.

To change the CD/DVD-ROM drive letter:

1. In the Computer Management window, position the cursor in the 
CDRom (Letter) area and right-click.

The following window appears.

2. Select Change Drive Letter and Path.
The following window appears.

3. Click the Edit button.

4. Assign a new drive letter, use E as the new drive letter.

5. Click OK.

Cursor
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6. Click Yes to confirm the change.
The CD-ROM drive letter changes.

You have completed all the procedures and are ready to use your 
external device.
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Overview
This appendix describes how to configure the connection between a Novell 
NDS (Novell Directory Services) Server and the CXP6000 Color Server, in 
a Novell working environment. 

To configure this connection, the following procedures are 
preformed:

1. Creating the Novell NDS Print Server "nwprintserver" in the Novell 
NDS.

2. Creating a Novell NDS Printer object in the Novell NDS.

3. Creating the Print Queues <hostname_ProcessPrint> and 
<hostname_ProcessStore> in the Novell NDS.

4. Verifying the connection information.

5. Configuring the IPX Printing parameters: Tree and Context, using the 
CXP6000 Color Server Administration window (Network Setup/IPX 
Printing) in the CXP6000 Color Server.

6. Installing the Printer Drivers on a Novell Client.

Important:  The Novell client should also be installed in the CXP6000 Color 
Server since it is not installed by default.

For further information see Installing and Configuring Novell Client for Spire on 
page 133.

Note:  All the following procedures should be performed on a Windows client 
running the Novell Client, and configured by the Novell Administrator to access 
the NWAdmin program.

Note:  Both <hostname_ProcessPrint> and <hostname_ProcessStore> 
queues should be defined even if you plan to use only one Printer queue. 
These print queues are the only supported Novell print queues.
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To perform these procedures, you need:

• Administrative permissions assigned by the Novell Administrator.

• The User Name and Password for access to the Novell NDS Server.

• An account in the appropriate NDS Tree and Context with permissions 
to create objects.

• The full Context (location in the NDS Tree) where you will be creating 
the Print Server, Printer and Print Queues.

• Background and know-how of Novell NDS Server.
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Defining Novell NDS Printer Queues in the Novell NDS Tree

Using the Novell NetWare Administrator Application
Perform the following procedures to create the Print Server, Printer and 
Print Queues, using the NWAdmin application:

1. Define the Novell NDS Print Server, Printer and Print Queue in the 
Novell NDS Tree.

2. Assign the Printer to the Print Server and the Print Queues to the 
Printer. 

3. Check the Print Layout to verify the connections and perform a test 
print.

Important:  The detailed procedures follow. Perform these procedures in the 
specified order.
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To open the Netware Administrator Application:

Open the Netware Administrator Application (provided by your 
Novell Administrator).
The NetWare Administrator window appears displaying the Novell 
NDS window. The following example shows the existing Trees, Queues 
and other Novell connections.
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To define a Novell NDS Print Server:

1. From the Novell NDS window, select the required Context.

2. From the Object menu, select Create.
The New Object dialog box appears.

3. From the Class of new object list, select Print Server.

4. Click OK.
The Create Print Server dialog box appears.

Note:  Before performing the following procedure, check the Novell Server 
window and if the nwprintserver already exists, proceed to the next procedure 
To define a Novell NDS printer: on page 166.

Note:  In Novell v5.0 NDS, the words “Non NDPS” also appear.
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5. In the Print Server name box, type nwprintserver.

6. Click the Create button.
The Novell NDS nwprintserver printer is created and appears in the 
Novell NDS window.

.

Notes:

It is important to use only this server name, in lower case. 

In any case, do not define a password for the Print Server.
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To define a Novell NDS printer:

1. From the Object menu, select Create.
The New Object dialog box appears.

2. From the Class of new object list, select Printer.

3. Click OK.
The Create Printer dialog box appears.

4. In the Printer name box, type any printer name, for example 
Spire_Printer.

5. Click the Create button.
The printer name is added to the Novell NDS window.

Note:  In Novell v5.0 NDS, the words “Non NDPS” also appear.
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To define the Novell NDS Print Queues:

1. From the Object menu, select Create.
The New Object dialog box appears.

Notes:

Both <hostname_ProcessPrint> and <hostname_ProcessStore> queues should 
be defined. Only these print queues are supported.

Prior to performing this procedure, verify that in the CXP6000 Color Server, both 
network printers <hostname_ProcessPrint> and <hostname_ProcessStore> are 
present.

Both Virtual printers <hostname_ProcessPrint> and <hostname_ProcessStore> 
should not be deleted from the CXP6000 Color Server.
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2. From The Class Of New Object List, select Print Queue. 

3. Click OK.
The Create Print Queue dialog box appears.

4. Verify that Directory Service Queue is selected.

5. In the Print Queue name box, type the exact (case sensitive) Virtual 
Printer name: <hostname_ProcessPrint>.
For example: Spire7_ProcessPrint.

6. Select the Create another Print Queue check-box.
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7. Click the Print Queue Volume icon.
The Select Object dialog box appears.

8. Select any existing volume.

9. Click OK.
The Print Queue volume name appears in the Print Queue Volume 
box, in the Create Print Queue dialog box.
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10. In the Create Print Queue dialog box, click the Create button.
The Print Queue is now added to the Novell NDS window along with 
the nwprintserver and the Printer name (Spire_Printer).

11. In the Create Print Queue dialog box, verify that Directory Service 
queue is selected.

12. Clear the Create another Print Queue check-box.

13. In the Print Queue name box, type the exact (case sensitive) second 
Virtual Printer name: <hostname_ProcessStore>.
For example: Spire7_ProcessStore.

14. Click the Print Queue Volume icon.
The Select Object dialog box appears.

15. Select any existing volume.

16. Click OK.
The Print Queue volume name appears in the Print Queue Volume 
box, in the Create Print Queue dialog box.

Note:  Notice that the Create Print Queue dialog box re-appears for the 
second Print Queue to be defined.
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17. Click the Create button.
Both queues appear now in the Novell NDS window.
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To assign a Printer name to nwprintserver Print Server:

1. In the Novell NDS window, double-click nwprintserver.
The Print Server dialog box appears.

2. Click the Assignments button to open the Assignments tab.
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3. Click the Add button.
The Select Object dialog box appears.
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4. From the printers, select the printer name you have defined 
(Spire_Printer in our example), and click OK.
The printer appears in the Printers list in the Print Server dialog box.

5. Click OK.
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To assign a Print Queue to the Printer:

1. In the Novell NDS window, double-click the Printer name you have 
defined (in our example Spire_Printer).
The Printer dialog box appears.

2. Click the Assignments button to open the Assignments tab.
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3. Click the Add button.
The Select Object dialog box appears.

4. Select the Queue name <hostname_ProcessStore> you have defined, 
and click OK.
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5. Click the Add button and select <hostname_ProcessPrint>.
Both printer queues now appear in the Print queues list in the Printer 
dialog box.

6. Click OK.
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To verify the new Novell NDS layout:

1. In the Novell NDS window, double-click nwprintserver.
The Print Server dialog box appears. 

2. Select the Print Layout tab.

3. Verify that the nwprintserver server, the printer and queues are 
displayed as shown in the above example.

4. Click the Cancel button.
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Using the Novell NDS PConsole 
The CXP6000 Color Server Virtual Printers can be defined as Novell NDS 
Printer Queues at the Novell NDS Server, using the Novell NDS PConsole. 
This procedure includes the following stages:

To use the Novell NDS PConsole:

1. In the CXP6000 Color Server, verify that the two Virtual printers 
<hostname_ProcessPrint> and <hostname_ProcessStore> are 
present.

2. In the Novell NDS PConsole:

Create the Novell NDS Print Server "nwprintserver".

Create the Novell NDS Printer object.

Create the Novell NDS Print Queues <hostname_ProcessPrint> 
and <hostname_ProcessStore>.

3. In the CXP6000 Color Server:

Configure the IPX Printing parameters: Tree and Context (the exact 
tree name and the full context path name) using the CXP6000 
Color Server Admin tool (General SetUp/IPX Printing).

Restart the CXP6000 Color Server Application.

4. Install the Novell Printer Queue on the Novell Client.

Notes:

It is important to use only this server name, in lower case. 

In any case, do not define a password for the Print Server.
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Configuring IPX Printing

To setup the CXP6000 Color Server IPX parameter:

1. In the CXP6000 Color Server workspace, click the Admin button.
The Administration window appears.

2. Double click Network Setup to expand the folder.

3. Double click IPX Printing.
The IPX Printing dialog box appears.

4. Type the exact Tree parameter and the full containers path of the 
Context parameter, in their respective boxes. You may also click the 
Browse button and browse to the required Tree and Path.

5. Click OK.

6. Restart the CXP6000 Color Server Software Application.

Note:  If the context and tree were defined during the Novell configuration 
process, these do not need to be defined again.
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Installing the Printer Drivers on a Novell Client Using the Adobe PS 
Application

To install the printer drivers on a Novell Client:

1. Use the Adobe PS Application with the CXP6000 Color Server PPD 
(provided in the CXP6000 Color Server, Utility folder). 

2. In the Adobe PS Wizard, verify that you have selected the Novell 
Printer Queue from the NetWare Network, and not the CXP6000 
Color Server Virtual printers. See the following example.



182 Appendix A – Novell NDS - Setup and Configuration

 

Following is an example of the Printers window after installing the 
Novell Printer Queue.

3. Perform a test print using the installed Novell NetWare printer. 

Note:  Note that the Novell Printer has the Novell NDS name as an extension, 
e.g. NW_TANSRV5.
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Defining the CXP6000 Color Server as a Novell NDS Client
The following procedure is performed only to connect the CXP6000 Color 
Server to Novell NDS, as a Novell client. You do not need to perform this 
procedure in order to print to the CXP6000 Color Server.

To define the CXP6000 Color Server as a Novell NDS Client:

1. Right-click Network Neighborhood icon on the CXP6000 Color 
Server desktop, and from the menu, select NetWare Login.
The Novell Login dialog box appears.

2. Type the Username and Password in their corresponding boxes; this 
information is provided by the Novell Administrator.

Note:  If the connection between the CXP6000 Color Server and the Novell 
Server has already been defined, verify the connection by following this 
procedure.
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3. Click the Advanced button to expand the dialog box.

4. In the NDS tab, click the Trees button.
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The Tree window appears.

5. Select the required tree and click OK.
The tree appears in the Tree box in the NDS tab.

6. In the NDS tab, click the Contexts button.
The context window appears.



186 Appendix A – Novell NDS - Setup and Configuration

 

7. Select the required context full containers path, and click OK.
The Context full containers path appears in the Context box in the 
NDS tab.

8. In the NDS tab, click the Servers button.
The server window appears.

9. Select the required Server, and click OK.
The Server appears in the Server box in the NDS tab.

10. Click OK in the Novell Login dialog box.

Note:  An optional way is to type the exact Tree name, the Context full 
container path and the Server exact name, in their corresponding boxes. 
These names are provided by the Novell Administrator.
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A Results window appears briefly to indicate that the connection was 
established. If an error message appears instead, contact your Novell 
Administrator.

The CXP6000 Color Server is now defined as a Novell NDS client.
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